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1 Introduction
Membrane structures represent attractive alternatives for the roofing of small and large objects:
they are lightweight, elegant, and effective at the same time. However, designing membrane
structures requires a specific procedure. Generally, the used materials do not feature any effective
bending stiffness. They can only absorb tension forces. Therefore, it is crucial of the design to
determine the initial equilibrium state. The shape of membrane structures is not freely selectable
but has to be found on the basis of boundary conditions, loading prestresses, and overpressures,
if applicable.

When planning membrane structures, the determination of the shape cannot be separated from
the prestress design (as it is possible for bending-resistant structures). The shape has to be gener-
ated. This will not at all restrict your creativity of design but will provide you with a new dimension.
A variety of shapes can be achieved by adjusting the boundary conditions or prestress. The ideal
prestress distribution is always individual; it results from the demands of the model.

The first chapter of this manual gives you an introduction on the topic of form finding, explaining
the key features of the calculation methods implemented in RF-FORM-FINDING. The second
chapter describes the individual dialog boxes and functions. The third chapter presents some
examples for learning how to work with the program. Another chapter with important notes is
followed by the final description of the add-on module RF-CUTTING-PATTERN.

1.1 Add-onModule RF-FORM-FINDING

The add-on module RF-FORM-FINDING of the main program RFEM helps you to find prestressed
initial shapes of membrane and cable structures as well as of models featuring “ordinary” beams
and surfaces with tensile or compressive forces applied. Those prestressed shapes can then be
analyzed by RFEM.

1.2 Essential Form Finding Process

In general, the materials used for membrane structures feature tensile capacities only. All loads
are transferred solely by tension. In order to ensure a sufficient resistance and shape consistency
of the membranes, an adequate prestress must be provided.

Due to the zero stiffness of the materials, it is not possible to separate the shape layout from
the prestress design – the shape is defined by the prestress. Each spatial equilibrium system of
forces (that is the equilibrium of prestressing forces) clearly determines the spatial shape of a
membrane structure. By defining boundary conditions and prestress forces in the equilibrium
state, the actual shape of the membrane model is set. Searching for the shape of a membrane
structure as a function of the defined prestress is called “form finding”.

There are two different approaches to the form finding process:

1. Definition of boundary conditions and loading prestress
The corresponding equilibrium shape is sought.

2. Definition of boundary conditions and shape (deformation) of the membrane
The equilibrium prestress is sought.

Both methods are valid and have their advantages. However, the interaction between shape and
loading prestress must never be neglected. With the second approach, you can affect the final
shape more easily, while the first one facilitates the design of the final prestress. As the loading
prestress is crucial for the bearing resistance and durability of the model, RF-FORM-FINDING
provides this method of form finding as well.
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1.3 Key Features of Form Finding Process

There is a direct correlation between the loading prestress and the shape of membrane structures.
The properties of the used textiles are irrelevant: the form finding process is independent of the
material.

In addition to boundary conditions and loading prestresses, the shape of a membrane model can
be also affected by loads. Thus, for pneumatically prestressed membranes, the program seeks
the equilibrium shape for the defined prestress and interior pressure. The latter can be applied
as a static load acting perpendicularly to the surface, or as a gas solid (ideal gas with isothermal
properties of state), see article 001507 of the Knowledge Base at our website.

The load due to self-weight may also affect the form finding process. It is possible to search for
a shape that corresponds to the specified prestress, self-weight (as well as other types of loads
contained in the Form-Finding category load case), and interior pressure, if applicable. In most
cases, the self-weight applied in the form finding process has only little effect on the final shape
and prestress as the self-weight of the textile is light.

1.4 CalculationMethods in RF-FORM-FINDING

The shape of a membrane structure is clearly defined by its boundary conditions and equilibrium
prestress, or by the equilibrium between prestress and loading (interior pressure, self-weight as
well as other loads of the Form-Finding load case). However, the definition of the equilibrium
prestress presents a problem, i.e. how to find the spatial equilibrium system of forces.

When planning a membrane structure, isotropic prestress is usually the only equilibrium prestress
that can be defined in advance. But such a prestress is not always suitable – in terms of both
the actual shape and the following nonlinear analysis. Moreover, it may occur that a shape that
conforms to the isotropic prestress is physically not possible due to specific boundary conditions.

Hence, it is necessary to specify an orthotropic prestress in the form finding process. A constant
orthotropic prestress in the equilibrium state is only possible if the Gaussian curve of the respective
surface is equal to zero (e.g. for plane or cylindrical surfaces). Double-curvedmembrane structures
are not characterized by this property. It would be necessary to apply a general spatial orthotropic
prestress to those membrane models. This would be unrealistic, however, and it would require a
tool that is able to find, in addition to the equilibrium shape, the equilibriumprestress by specifying
the prestresses in two directions (warp and weft directions).

In RF-FORM-FINDING, two calculation methods are implemented that can be used to find equi-
librium shapes and prestresses – the projection method and the tension method. Both methods
are based on the familiar Updated Reference Strategy (URS) form finding method published by
K.U. BLETZINGER and E. RAMM in 1999.

In general, the projection method is advantageous for high conical shapes, while the tension
method is more appropriate for membranes supported by points and arches or for pneumatically
stabilized membranes. The tension method is defined as Standardmethod in RF-FORM-FINDING.

https://www.dlubal.com/en-US/support-and-learning/support/knowledge-base/001507


1 Introduction

©DLUBAL SOFTWARE 2019

4

1
1.4.1 ProjectionMethod

As already mentioned, it is virtually impossible to define a general equilibrium prestress in space.
Yet it is possible in a plane where a constant orthotropic prestress (orthogonally aligned prestress)
may exist besides isotropic prestress. Furthermore, when defining a loading prestress in the radial
direction, it is also possible to determine the prestresses in the tangential direction for all adjacent
points on the basis of a certain equilibrium condition. Thus, it is possible to clearly define an
equilibrium system of forces in a plane.

These conditions are used by the projectionmethod. It is based on the “projection” of the prestress
defined in the global XY plane into the actual position of the membrane structure (or the surface
othogonal to the directive axis of a radial coordinate system). If the inclination of the membrane
against the projection plane is equal to zero, the prestress in the membrane corresponds to the
specified values. If its inclination against the projection plane is unequal to zero, the prestress
in the fall line direction increases while the prestress in the contour line direction decreases. If
the inclination against the projection plane is almost perpendicular, the prestress in the fall line
direction increases significantly while the prestress in the contour line direction is close to zero.

The projection method allows the prestress equilibrium to be preserved in the directions of the
global axes X′ and Y′ within the projection plane. In the form finding process, the program then
seeks the layout of the membrane structure in space that retains the equilibrium prestress also in
the direction of the global axis Z′ perpendicularly to the plane. The projection method – which
determines the equilibrium prestress in the projection – leads to the definition of the equilibrium
prestress in space and, thus, to finding a clear spatial shape of the membrane structure.

To find the equilibrium state, the Updated Reference Strategy (URS) method is used. Therefore, the
form finding process represents a nonlinear problem.

1.4.2 TensionMethod

The tension method is set as Standardmethod in RF-FORM-FINDING.

This method is very different from the projection method: the defined prestress is not modified,
i.e. stabilized. When determining the equilibrium shape, the tension method applies the two set
values that have been defined for the prestresses in the warp and weft directions.

In most cases, a prestress that is physically out of equilibrium (except isotropic prestress) is defined.
Therefore, when applying an orthotropic prestress (e.g. 2.0 kN in the warp and 1.0 kN in the
weft directions), it is unlikely that a shape of the membrane structure is reached with a loading
prestress that exactly meets these requirements. Since the requirement for a constant orthotropic
prestress usually reflects no adequate solution, the shape would not converge to the equilibrium
position when using this prestress repeatedly in the iteration process. For this reason, the selected
prestress in themembranemodel is applied only in a user-defined number of iterations. After that,
a stabilization is applied.

The tension method uses the fact that, when defining a loading presstress out of equilibrium
for the membrane structure, the deformations perpendicularly to the plane of the membrane
are more frequent than the deformations within the plane. As soon as the defined number of
iterations for applying the specified prestress has been reached, the structure is stabilized. The
resulting prestress then comes usually very close to the specified values. The tension method is
also based on the Updated Reference Strategy (URS) method of form finding.
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1.5 Form Finding for Combined Structures

While the shape of membranes in RF-FORM-FINDING is determined by means of the defined pre-
stress values, it is possible for cables to define, in addition to prestresses, geometrical requirements,
such as the final rise or length. Same applies to “ordinary” beams and surfaces featuring tensile
and compressive attributes.

Membranes are often parts of a structure that contains many bending-resistant elements (beams,
plates, shells, etc.) During the form finding process, an equilibrium shape of the entire model is
sought. The prestress in the membrane and cables has an active effect on the rigid elements of
the structure which have to counteract that prestress. If you do not want to consider the influence
of rigid elements in the form finding process, you can supply them with specific temporary form
finding supports to fix the objects for the form finding analysis. It is at your individual discretion
which variant of the construction assembly is the most appropriate for the structure.

1.6 Add-onModule RF-CUTTING-PATTERN

The RF-CUTTING-PATTERNmodule represents the second component in the RFEM product family
that is used for membrane structures. It generates and organizes cutting patterns for membranes
that are available as results of the form finding process. Alternatively, RF-CUTTING-PATTERN can
be used for self-defined spatial membrane systems.

If the division of the membrane surfaces is too large for cutting, it is possible to divide the surface
into partial strips by cutting lines. The boundary conditions of cutting patterns on the curved
geometry can be determined by means of boundary lines or by independent planar or geodesic
cutting lines. The flattening process is performed according to the theory of minimum energy.

Prestress and stresses from flattening are applied by compensations. In addition, allowances for
welds and boundary connections can be defined separately for each cutting pattern.

Chapter 5 gives you a detailed description of the RF-CUTTING-PATTERN add-on module.
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2 RF-FORM-FINDING
This chapter describes the dialog boxes and functions of the RF-FORM-FINDING add-on module.

2.1 Open Add-onModule

To work with RF-FORM-FINDING, it is necessary to activate the add-on module first: Select the
RF-FORM-FINDING check box which you can access in the Options tab of the NewModel - General
Data or Edit Model - General Data dialog boxes.

Figure 2.1: Activating RF-FORM-FINDING in NewModel - General Data dialog box

A new load case with the description RF-FORM-FINDINGwill be created automatically when the
add-on module is activated while defining the general data of a newmodel. This load case man-
ages specific parameters and the results of the form finding process.
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2.2 Dialog Boxes of Add-onModule

The activated RF-FORM-FINDING add-onmodule provides the following dialog boxes and features
in the user interface of the main program RFEM.

2.2.1 Calculation Parameters for Form Finding

The Form-Finding tab of the Calculation Parameters dialog box manages basic options concerning
the the form finding. To access this dialog box, click the toolbar button shown on the left.

Figure 2.2: Dialog box Calculation Parameters, tab Form-Finding

Settings
This section of the tab controls theMaximum number of iterations for the nonlinear calculation as
well as the Number of iterations for loading prestress.

Options
With the preliminary form-finding you can accelerate the calculation: prior to the actual formfinding
process, the mesh nodes will be moved to a position that is close to the target geometry taking
solely into account the membrane and cable elements. Based on this approximation, the form
finding is carried out taking into account all effects from the entire structural system.

There is also an option to Generate NURBS surfaces and lines from the results of the form finding
process. The generation of NURBS surfaces is only possible for surfaces that are defined by three
or four lines, however. After this transformation, it is recommended to deactivate the option Hide
Membranes and Cables in the Display navigator.

Precision and Tolerance
This section controls the tolerance of the convergence criteria for the form finding process. In
general, it is not required to modify the default values.

The Target length of finite elements for immediate graphic update of FF elements controls the mesh
settings used to calculate the approximate shape ofmember elements (see Chapter 2.2.3, page 11).
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2.2.2 Surfaces of Types ‘Membrane’ or ‘Standard’

The calculation method as well as the prestress parameters for Standard orMembrane surfaces
can be defined in a specific dialog box. It appears when clicking the button next to the list of
surface types in the New Surface (or Edit Surface) dialog box or the button in Table 1.4 Surfaces.
Select the Standard,Membrane orMembrane - Orthotropic stiffness type in the drop-down list first.

Figure 2.3: Selecting stiffness type and [Edit] button

In the Edit Surface Stiffness dialog box, you decide whether the Standard tension method or the
Projectionmethod is to be applied for the calculation. Both methods are described in Chapter 1.4.

Figure 2.4: Dialog box Edit Surface Stiffness for membrane surface
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The Prestress can be defined as Force or Stress. The warp and weft directions are linked to the axes
of the surface (see Axes tab of Edit Surface dialog box). In the default setting, you can apply only
an isotropic prestress. If the axes are aligned, orthotropic or radial prestress is also available.

For pneumatic membranes, you can specify the Interior pressure, pp, in the Load section. Alterna-
tively, the load can be defined in a load case of the Form-Finding action category.

Nonlinear materials

If the add-on module RF-MAT NL is available, nonlinear materials can be used for the surfaces to
apply their properties to the form finding analysis. The features of the material can be defined in
the dialog boxes of the selectedMaterial Model.

Figure 2.5: Dialog boxesMaterial Model - Isotropic Nonlinear Elastic 2D/3D

For the form finding process, these nonlinear material models are applicable:

• Isotropic nonlinear elastic 2D/3D

• Isotropic plastic 2D/3D

The nonlinear materials are described in the RFEMmanual, Chapter 4.3 Materials.
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2.2.3 Members of Types ‘Beam’ or ‘Cable’

To define the parameters for the form finding process of cables (tensile forces) and beams (tensile
and compressive forces), open the NewMember or Edit Member dialog box or Table 1.17Members.
Select the Cable or Beammember type in the drop-down list. Then click the or button.

Figure 2.6: Selecting member type and [Edit] button

In the Edit Parameters dialog box, you can set the geometrical conditions or forces of the member.

Figure 2.7: Dialog box Edit Parameters for Member of Type 'Cable'
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Figure 2.8: Dialog box Edit Parameters for Member of Type 'Beam'

Activate the check box to access the parameters of the member.

For beammembers, the specific parameters can be set for Tension or Compression. Cablemembers
only absorb tensile forces.

If you select the parameters of Geometry, you can define either the Target cable/beam length
(absolute/relative) or the Target cable/beam sag (absolute/relative). This option is relevant for cable
or beammembers at the borders of membrane structures.

If you select the parameter of Force, you can enter the Average force in cable/beam or the Force
density. This option is suited to analyze cable webs or to determine the adequate inclination of
column beams, for example.

When you activate the Show Preliminary Form-Finding option available in the general shortcut
menu, the approximate shape of the model is determined according to the force density method.
That “estimated” shape will then react to anymodification of the topology as well as of the loading.
Note that this option is only effective for Force type parameters (see above) of the cable or beam.

Figure 2.9: Shortcut menu item Show Preliminary Form-Finding to calculate approximate shape
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2.2.4 Temporary Form Finding Supports

For the RF-FORM-FINDING module, a specific type of support Nonlinearity is available for nodes,
lines, and surfaces. It can be set for supports that are only effective during the form finding process.

Figure 2.10: Temporary nodal support for form finding stage

Figure 2.11: Temporary line support for form finding stage
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Figure 2.12: Temporary surface support for form finding stage

Chapter 3.2 gives you an example how to apply temporary form finding supports to an arch-sup-
ported membrane.

2.2.5 Form Finding Load Case

Loads that are essential for the form finding process, such as self-weight or gas pressure, are to be
managed in one specific load case. As Action Category, the Form-Finding type has to be allocated.
Create only one load case featuring this category and define all relevant loads there.

Figure 2.13: Allocating Form-Finding action category
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The Form-Finding action category implies that the specific loads are considered for the formfinding
process only, not for the subsequent analysis of the final state of the membrane or cable model.

Loads that are relevant for form finding are managed as “ordinary” loads: you can double-click a
load in the work window to open its Edit dialog box and adjust the parameters, for example.

Figure 2.14: Modifiying load in Edit dialog box
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2.3 Start Calculation

When activating the RF-FORM-FINDING add-on module (see Figure 2.1), a new RF-FORM-FINDING
load case is created. You can start the calculation of this load case as usual in the RFEM toolbar or
the drop-downmenu.

Figure 2.15: Options to start form finding analysis in toolbar

Figure 2.16: Options to start form finding analysis in menu

When the calculation is started, the program initiates the form finding process. It is performed on
the model, taking into account the specified values and the Form-Finding category load case, if
applicable.

As soon as the prestressed shape of the membrane or cable structure has been generated, the
load cases (except for the Form-Finding type load case) are applied to the new shape of the model.
Thus, the form finding process represents the first phase of the calculation where the prestressed
shape is created. The loads defined in all load cases and load combinations will be applied to it –
but for the Form-Finding load case, as mentioned above – when the Calculate All option is selected.

When the RF-FORM-FINDING add-onmodule has been activated, it is not possible to calculate “real”
load cases without any previous form finding analysis. When you start the calculation of a load
case without the compulsory form finding, the RF-FORM-FINDING case is calculated automatically
first. The analysis of the load case will then be based on the resulting prestressed shape.

Do not calculate the Form-Finding type load case when the shape has already been found. Its
only function is to find the form of the structure. If you calculated it once more manually, its loads
would be taken into account again on the distorted model.
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2.4 Results Display

The results of the form finding process are displayed in a similar way as load case results. You can
control the results display in the Results navigator (Figure 2.17). The results are also displayed in
Table 4.0 Results - Summary (Figure 2.18).

Figure 2.17: Results navigator

Figure 2.18: Table 4.0 Results - Summary

After the form finding analysis, the Results navigator features the Shape entry with three subentries
(see Figure 2.17). The Contour Lines option shows the outlines of the model. They represent the
Z-coordinates of every mesh point as isobands, for example. Alternatively, you can display the
maximum Inclination on each location of the membrane. The angles can as well be displayed as
Inclination Direction.
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When you select the Isobands option for the surface results, the contour lines of the generated
model are displayed in a colored view. The Color Scale tab of the panel illustrates the legend.

Figure 2.19: Panel illustrating contour lines of membrane model

The button in the panel enables you to display user-defined level curves of the generated
shape. Enter the intervalwhich is to be applied for the black isolines.

Figure 2.20: Options panel for level curves
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The form finding analysis entails a distorted shape of the inital FEmesh: the new shape of themesh
replaces the original one. You can activate the newmesh in the Display navigator by selecting

FEMesh (Form-Finding) → OnMembers,

FEMesh (Form-Finding) → On Surfaces and/or

FEMesh (Form-Finding) → In Solids.

Figure 2.21: Displaying newmesh shape in Display navigator

The newmesh – inclusive of its implicated loading prestress – is applied to all subsequent calcula-
tions of load cases and combinations.

Due to the form finding process, the point of the FEmesh are moved to new locations. The initially
modeled surfaces or members remain in their initial positions, however.

To hide or show the original model, use theModel selection in the Display navigator.

The Generate NURBS surfaces and lines option, which is available in the Calculation Parameters
dialog box (see Figure 2.2, page 7), enables you to transform the shifted mesh into NURBS objects.
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Member lengths

For cable or beammembers that have been activated for the form finding analysis, the Unstressed
Length or Stressed Length can be displayed in the work window and in Table 4.4.2 Members - Shape.

Figure 2.22: Displaying unstressed and stressed lengths of cables

As seen in Figure 2.22, the graphics can be controlled by theMember Length options of the Results
navigator. When you activate theUnstressed length, you can retrieve the lengthswhich are required
for the fabrication of each cable.
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3 Examples
This chapter contains some examples that show you how to work with the RF-FORM-FINDING
add-on module. It presents characteristic types of membrane structures, such as point-supported
membranes, arch-supported membranes, conical membranes, and pneumatic membranes.

When working with RF-FORM-FINDING, the first step is always to create a model which defines the
individual surfaces, cables, supports, and so on. This model represents the “initial approximation”
of the final shape. During the form finding analysis, the model is then distorted into its new
position. This process represents a function of the specific input parameters for form finding.

The dialog boxes described in Chapter 2 are used to define the loading prestress for the surfaces
of theMembrane orMembrane - Orthotropic types and to set the warp and weft directions. For the
cable members, the geometrical conditions or forces are defined.

3.1 Point-SupportedMembrane

This example presents an ordinary point-supportedmembrane. In the first step, amodel consisting
of cables, a membrane, and supports is created in RFEM (see Figure 3.1).

Figure 3.1: Model of point-supported membrane

The calculation method can be defined in the Edit Surface Stiffness dialog box (see Figure 3.2).
In general, the Standard (tension) method is advantageous for membranes that are supported
by points or arches, or for pneumatically stabilized membranes, while the Projectionmethod is
appropriate for conical membranes. For this reason, the default Standardmethod is adequate.
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Wedefine values of prestress for theMembrane surface and for the Cablemembers. Themembrane
requires an isotropic prestress of 1.0 kN per meter of width (see Figure 3.2). For an isotropically
prestressed shape, the warp and weft directions are not significant. The cables require an average
prestress of 10 kN (see Figure 3.3).

Figure 3.2: Prestress defined for membrane

Figure 3.3: Prestress defined for cables

As soon as the model has been created and the input parameters relevant for form finding have
been defined, the calculation of the RF-FORM-FINDING case can be started.
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As a result of the form finding analysis, a new shape of the structure is created.

Figure 3.4: New shape of structure

Figure 3.5 shows the of internal forces of the membrane and of the cables. Additionnally, it is
possible to display the support reactions.

Figure 3.5: Vectorial display of principal internal forces in membrane and axial forces in cables

Figure 3.5 shows that the resulting prestresses already correspond fairly well with the initial values.
As the isotropic prestress is a spatial equilibrium prestress, the approximation can yet be improved
by modifying the default settings in the Form-Finding tab of the Calculation Parameters dialog box
(see Figure 2.2). Figure 3.6 shows the resulting internal forces after having increased the Number
of iterations for loading prestress.
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Figure 3.6: Resulting prestress due to increased number of iterations

The prestressed membrane structure can subsequently be subjected to a LC/CO analysis. We can
create load cases, define loads, and start the calculation. The load cases will be calculated on the
basis of the generated prestressed shape. Thus, the form finding can be considered as the first
phase of the analysis, the calculation of all other load cases as its second phase.

If the structural analysis proves the isotropic prestress to be inappropriate for the structure, an
orthotropic prestress can be defined instead. For it, the direction of the axis system has to be
adjusted accordingly in the Axes tab of the Edit Surface dialog box first.

Figure 3.7: Dialog box Edit Surface, tab Axes (detail)

After that, the input values can be adjusted in the dialog boxes of membranes and cables. In our
example, we set the prestress to 2 kN/m in thewarp and to 1 kN/m in theweft directions. For the
orthotropic prestress, the warp and weft directions are controlled by the axis system of the surface.
The border cables are to be prestressed by average forces of 15 kN now.

In the Edit Surface Stiffness dialog box (see Figure 3.2), the text box of the weft direction is available
now. If the samevalue as for thewarpdirection is set (isotropic prestress), a spatial force equilibrium
system is defined. By increasing the precision and number of iterations for the loading prestress,
we will obtain more exact results. The size of the FE mesh elements affects the precision to a
certain extent as well: in general, the shape in space corresponding with the equilibrium prestress
approximates better with a refined mesh.
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We define a constant orthotropic prestress by setting the prestress to 2 kN/m in the warp and
to 1 kN/m in the weft directions. It cannot be expected that an equilibrium prestress in space is
reached by this. Therefore, the selected prestress is applied to a limited number of iterations only –
until the membrane structure is stabilized. Thus, the program is in most cases able to find a shape
that approximates well to the specified values (see Figure 3.8).

Figure 3.8: Orthotropic prestressed membrane

Regarding the Number of iterations for loading prestress of a model, the following is recommended:

• If there is an isotropic prestress, an increased number of iterations will create a shape that
better and better approximates to the force equilibrium system in space.

• For a constant orthotropic prestress (i.e. the spatial force system is not in equilibrium), the
effect of the prestress must be stopped at the right moment. It will be then when the de-
formation represented in the Maximum Displacement diagram stops rising distinctly (see
Figure 3.9).

Figure 3.9: Graphical display of deformations during form finding process
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Deformations perpendicular to the plane of the membrane (usually in the steep part of the curve)
are far more frequent than those within the plane of themembrane. As soon as the increase of the
deformation falls off, the program has usually found the shape that corresponds approximately to
the required orthotropic prestress. After the last application of the constant orthotropic prestress,
the structure is stabilized. Thus, an equilibrium prestress is reached which is very close to the
specified values.

The equilibrium shape is completely independent of the stiffness of the used materials. The shape
of a flexible structure clearly results from the defined boundary conditions and the equilibrium
prestress, or it is defined by the boundary conditions and the equilibrium system of loading
prestress and loads (overpressure, loads of the Form-Finding category load case). The usedmaterial
only affects the resulting shape when its self-weight is considered for the form finding. This load
has only little influence in general, however.

Therefore, it is recommended not to activate the self-weight at the beginning of the form finding
process. This way, you can find the prestressed shape that meets your expectations first. Then
select the appropriate material, activate the consideration of the self-weight in the Form-Finding
load case, and start the calculation once again.

Similarly, the final shape is independent of the initial approximation of the shape. In other words, it
does not matter how “precisely” the initial structure is modeled. It is only important to adequately
arrange the supports and define the loading prestresses. Under these conditions, the final shapes
of different initial models will be the same (see Figure 3.10 and Figure 3.11).

Figure 3.10: Models featuring two different initial shapes

Figure 3.11: Identical shapes after form finding process

Decisive for the final shape are not the absolute values of prestresses, but their ratios: Irrespective
of whether you define an isotropic prestress of 1 kN/m for themembrane and an average prestress
of 10 kN for the cables, or a prestress of 50 kN/m for the membrane and an average prestress of
500 kN for the cables, the result will be an identical shape for both versions. This does not apply,
however, if semi-rigid beams are set as boundary conditions. Those will be deformed differently
when varied prestresses are applied to the membrane (see example in Chapter 3.2).
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3.2 Arch-SupportedMembrane
This example presents an arch-supported membrane. The structure consists of three membrane
panels and four steel arches. The membranes are laterally connected to the beams and anchored
at their bottom edges. The steel arches are fixed in the foundation (see Figure 3.12).

Figure 3.12: Model of arch-supported membrane

In the first step, amodel is defined in RFEM representing an initial approximation to the final shape.
For example purposes, there is a different loading prestress for each membrane panel. The first
panel is defined with an isotropic prestress of 1 kN/m, the second and the third panel with an
orthotropic prestress. The loading prestress in the second panel is 1 kN/m in the warp direction
and 2 kN/m in the weft direction while the third panel has a loading prestress of 2 kN/m in the
warp direction and 1 kN/m in the weft direction.

In the Edit Surface Stiffness dialog box, the calculation method for form finding can be defined
for each of the three surfaces (see Figure 3.2). In general, the Standard (tension) method is
advantageous for arch-supported membranes. In the Calculation Parameters dialog box (see
Figure 2.2 on page 7), the number of iterations for the loading prestress can be set.

As there is an obvious correlation between the loading prestress and shape, different membrane
shapes result due to varied prestress values for the panels (see Figure 3.13 and Figure 3.14).

Figure 3.13: Final shape of membrane structure - isometric view

Figure 3.14: Final shape of membrane structure - view in -Y
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Figure 3.15 shows the internal forces on the generated shape of the membrane structure. Again,
there is a good approximation of the resulting prestress to the required prestress.

Figure 3.15: Vectorial display of principal internal forces in membrane and axial forces in beams

The steel arches are subjected to the form finding process, too. They represent flexible boundary
conditions for themembrane surfaces. The defined loading prestress is applied to themembranes,
which the beams must resist. Thus, the result of the form finding is not only the prestressed shape
of the membranes, but also the distorted shape and the internal forces of semi-rigid parts of the
structure. Due to the loading from the membranes, the steel arches deform according to their
stiffnesses.

If you wish to exclude the steel arches from the form finding process, it is possible to support them
by temporary form finding supports (see blue supports in Figure 3.16).

Figure 3.16: Arches with temporary supports for form finding

Those supports have the nonlinear property of Form-finding stage only (see Figure 3.17). They
are effective for the form finding process only and will not be considered for other load cases –
similarly to constructional supports. All loads which the temporary supports have to resist for the
form finding will then be absorbed by the steel arches.
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Figure 3.17: Temporary line support for Form-finding stage only

It is up to you whether semi-rigid parts of the structure are to be considered for the form finding
process or ignored by means of temporary supports. You can make your decision depending on
the procedure of assembly.

• If there are no constructional supports for the restrained arches during the assembly, they will
deformwhen themembrane is tightened. This corresponds to the form finding process when
no temporary supports are used. The loading prestress which is available after tightening the
structure corresponds to the prestress resulting from the form finding process.

• If the beams are supported by construction supports while tightening the membrane, it
can be simulated by temporary support for Form-finding stage only. When the membrane
has been tightened, support reactions occur in the constructional supports. As soon as the
supports are removed, the steel arches must resist those forces and will be deformed. Hence,
the internal forces in the membrane will be modified as well. This corresponds to the analysis
of the structure supplied with temporary supports when starting an “ordinary” load case
which has no loads: as the temporary supports are deactivated in this step of form finding,
the beams are subjected to all loads and will deform. The deformation of the beams also
affects the loading prestress in themembranes. This constitutional change in RFEMdue to the
eliminated temporary supports corresponds to the process of removing the constructional
supports.
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3.3 Pneumatically SupportedMembrane

This example presents a pneumatically stabilized membrane. The shape of the membrane is
determined by the boundary conditions, a loading prestress and internal pressure. For illustration,
two membrane structures with different prestress conditions are modeled in the global plane XY.

For this type of membrane structures, the Standard (tension) method is advisable.

Figure 3.18: Initial geometry of pneumatic membranes

The models will be deformed into an equilibrium position according to the defined values of
loading prestress and internal pressure. The model to the left has an isotropic prestress of 1 kN/m,
the model to the right orthotropic prestresses of 2 kN/m in the warp direction and of 1 kN/m in
the weft direction (see Figure 3.19).

To apply the internal pressure, two alternatives are available: it can be defined either as Interior
Pressure (static load) or as a Solid Load (gas).

3.3.1 Internal Pressure as Static Load

Figure 3.19: Definition of orthotropic prestress and internal pressure
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Theoverpressureof−400 Pa is identical for bothmodels (see Figure 3.19). Positive internal pressure
acts in the direction of the local z-axis of the surface, negative interior pressure against the local
z-axis of the surface. In our example, the pneumatic models are to be deformed upwards, i.e.
against the local z-axis of the surface, which means that the load is entered with a negative sign.

When the calculation has been started, the models converge against the equilibrium shapes.

Figure 3.20: Final shapes of membrane structures

Figure 3.21 shows a good approximation of the resulting prestresses to the required prestresses
of the membrane structures. Note the difference between isotropic and orthotropic features of
the two surfaces.

Figure 3.21: Vectorial display of prestresses in membranes
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3.3.2 Internal Pressure as Gas Solid

To apply a gas solid between surfaces, the initialmodels have tomodified. The plane initial surfaces
each have to be changed into two adequate surfaces which allow for the definition of solids.

In our example, we define B-Spline geometrical shapes enclosing the gas.

Figure 3.22: Definition of B-Spline Surface

In the Edit Surface Stiffness dialog box (see Figure 3.19), we set the Interior pressure, pp, to zero for
every surface.

We define two solids of theGas type between themembrane surfaces (see Figure 3.23). Asmaterial,
we can select Dry Air from the library.
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Figure 3.23: Dialog box New Solid

Nextwe create anew load casewhoseActionCategory is tobe set toForm-Finding (see Figure 2.13).
We deactivate the self-weight.

For the two solids, we define a new solid load each. We select the Gas load type and enter its
magnitude of 400 Pa.

Figure 3.24: Dialog box New Solid Load
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After the form finding analysis, the shapes of both models have been found. As can be seen in
Figure 3.25, the deformation of the membrane structure with the higher (orthotropic) prestress
turns out to be slightly less.

Figure 3.25: Final shapes of membrane structures

The prestresses in themembrane are fairly close to the ones of themodel which has been analyzed
in the previous chapter (see Figure 3.21).

Figure 3.26: Vectorial display of prestresses in membranes
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3.4 Conical Membrane

The last example presents a conical membrane structure. The inital model, i.e. the first approxima-
tion to the shape of the structure, consists of several membrane surfaces and cables, a peak ring,
and a central pylon.

Figure 3.27: Initial geometry of conical membrane structure

For conical membranes, the Projectionmethod is recommended for the form finding process.

As described in Chapter 1.4.1 on page 4, the projection method is based on a loading prestress
predefined in the projection plane which is then adjusted according to the inclination of the
membrane. If the inclination of the membrane increases, the prestress in the directions of the
fall lines increases as well, while the prestress in the directions of the contour lines decreases.
If an isotropic prestress is defined in the projection, the result will be a general prestress of the
membrane structure in space.

The central pylon bearing the membrane structure is simply supported in its footing. This type of
support allows for the pylon to tilt during the form finding process as well as when tightening the
structure. Please note that it is necessary to secure the pylon for both the form finding analysis
and the construction phase, e.g. by a Form-finding stage only type (provisional support) at its top
(see Figure 3.27). It would also be possible to use some other temporary support, e.g. a rotational
restraint at the footing. In any case, the semi-rigid part of the structure must be stable during the
form finding and construction phases.

When the initial model has been created, the required prestresses are to be defined. An isotropic
prestress (in projection) of 1 kN/m is assigned to the membranes. The cables are prestressed by
an average force of 10 kN each.

After the form finding analysis, the equilibrium shape shown in Figure 3.28 is displayed.
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Figure 3.28: Final shape of membrane structure

The resulting prestresses are shown in Figure 3.29.

Figure 3.29: Vectorial display of prestresses in membranes

Asalreadymentioned, an isotropic prestress defined in theprojection leads to ageneral orthotropic
prestress in the spatial position of themembrane. The loading prestress depends on the inclination
in the respective location. In bottom parts of the membrane where the inclination is small, the
loading prestress approximates to the isotropic prestress (predefined in the projection), while the
loading prestress on top of the cone is changed significantly due to the strong inclination.

The loading prestress can be adjusted in the Edit Surface dialog box, if necessary: you can define
a radial arrangement of the warp and weft directions (see Figure 3.30) and specify the prestress
values accordingly (see Figure 3.32).
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Figure 3.30: Radial arrangement of axes in Edit Surface dialog box, tab Axes

For radial arrangements, an orthotropic equilibrium prestress existing in the plane cannot have
two constant values (in contrast to an orthogonally aligned prestress in the plane). Due to the
radial arrangement, the radial forces are affected by the tangential forces: they increase the radial
forces in the centric direction because of the curvature.

If you select an orthotropic prestress with radial arrangement, the values of the prestress in the
warp and weft directions refer to the point in the projection which is located at a specific distance,
r, from the center (see Figure 3.31). This radius is determined automatically halfway between the
center and most distant point. It is relative to the reference plane and perpendicular to the axis
of alignment. In all other distances, the radial prestress is calculated in such a way that it is at
equilibrium in the plane. Thus, it is possible to project the force equilibrium system in the spatial
position of the membrane.

Figure 3.31: Radial prestress in Edit Surface Stiffness dialog box
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The radial field of the prestress in the projection can be adjusted by means of the forces specified
in warp and weft directions as well as by the distance of the defined prestress from the center.
The prestress values available in the center, which are small at first sight, are rising concordantly
with an increasing inclination of the membrane. This can be illustrated very well in the example
of the conical membrane: the modification of loading prestress from isotropic to othotropic (see
Figure 3.31) leads to the final shape of the membrane structure shown in Figure 3.32.

With different settings for prestress, different shapes will be generated, too.

Figure 3.32: Final shape of membrane structure

Figure 3.33: Resulting prestress

For further demonstration of the projection method, it would be possible to move the ring points
of the conical membrane into a plane and to generate different prestresses in the projection. Then
the position of the ring could be moved upwards to compare the changes of the prestress as a
function of the inclination. For uniform specifications (isotropy in projection, for example), the
resulting prestress in space would vary significantly.
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The projection method is suited for high conical membranes as it prevents the membrane gorge
from narrowing – an effect of the standard (tension) method. Figure 3.34 shows one of the results
which may be created when the Tension calculation method is applied.

Figure 3.34: Result of standard (tension) method

The final shape is also affected by the number of iterations that have been set for the application
of loading prestress.
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4 General Notes

4.1 Check of Settings

If a membrane structure consists of several surfaces (see Chapter 3.4), it is assumed that the
same values for prestress as well as identical warp and weft directions are defined for all surfaces.
Otherwise RFEM will display a corresponding warning.

Figure 4.1: Warning

If there are independentmembranes or if the individual surfaces are separated by supports, cables
or beams, however, they are considered as independent surfaces. The compatibility of input data
will not be checked in those cases.

Figure 4.2 shows the layout of an arch-supportedmembrane. The central panel is dividedby a cable.
Members are indicated in Roman, surfaces in Arabic numerals. RFEM wil check the compatibility
for surfaces 1 and 2 and for surfaces 5 and 6.

Figure 4.2: Surfaces of arch-supported membrane
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4.2 Triangle Elements

For modeling membrane structures, it is recommended to generate the FE mesh with triangle
elements. In the case of rectangle elements, warping effects occur. Therefore, membrane surfaces
are automatically meshed with triangle elements.

The settings are managed in the FEMesh dialog box that you can access by selecting Calculate →
FEMesh Settings on the RFEMmenu bar.

Figure 4.3: Opening FEMesh Settings

Figure 4.4: Dialog box FEMesh, tab FEMesh Settings
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4.3 Cables

There are two options available for defining the Force in each cable:

• The Average force in cable is to be set for cables that are connected with the membranes of
the structure.

• The Force density is to be applied to pure cable webs.

Figure 4.5: Defining force in cable

If an Average force in cable is set and the defined value proves to be too low during the calculation,
the cable will be stiffened when exceeding the length ℓc = 0.4𝜋 ℓ. Thus, no strain will occur
anymore in the cable (ℓ being the distance between the points i and j, see Figure 4.5).

The values specified as required prestress or geometry of cables are considered as the resulting
values in space. The values entered for cables are not adjusted according to the inclination (such as
for membranes) when applying the projection method because they do not represent the explicit,
that is the physically real data.
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5 RF-CUTTING-PATTERN
This chapter describes the dialog boxes and functions of the RF-CUTTING-PATTERN add-onmodule.

5.1 Open Add-onModule

To work with RF-CUTTING-PATTERN, it is necessary to activate the add-on module first: Select the
RF-CUTTING-PATTERN check box which you can access in the Options tab of the New Model -
General Data or Edit Model - General Data dialog boxes.

Figure 5.1: Activating the RF-CUTTING-PATTERN in NewModel - General Data dialog box

RF-CUTTING-PATTERN can be used for self-defined spatial surfaces as well as for structures that
have been created with the RF-FORMFINDING add-on module.

When the add-on module has been activated, the additional entry Cutting Patterns is available in
the Data navigator.
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5.2 Cutting Lines

The cutting pattern must be defined via boundary lines. If the arrangement of the membrane
surfaces in the basic position is too large for cutting, it is possible to divide every surface into partial
strips by means of cutting lines. For this, RF-CUTTING-PATTERN offers two special line functions.
You can access them on the Lines shortcut menu or on the menu

Insert → Model Data → Lines → Cut via Two Lines or Cut via Section.

Figure 5.2: Line types for RF-CUTTING-PATTERN on Lines shortcut menu

Those two line types do not affect the geometry of the model. Thus, they can be defined indepen-
dently of the model.

The cutting lines are only shown in the graphic when the FEmesh has been generated. If themesh
is missing, the corresponding navigator entries are marked in red.

In the dialog box of each line type, at first enter the surface on which the line lies (see Figure 5.3).
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Figure 5.3: Dialog box New Line, tab General

The surface can be determined graphically with the button. As the lines can also be set on
several surfaces, multiple entries are possible.

Cut via two lines

Figure 5.4: Dialog box New Line, tab Cut via Two Lines

In the second tab of this dialog box, specify the lines and the points on the lines that represent
the definition nodes of the cutting line. The lines can be selected graphically with the button.

With the button, you can switch between the input of relative and absolute distances.

Use the button to determine the relative distances graphically in the work window.
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In the Cut Type section of the dialog box, you define how the cutting line is to be created:

• Geodesic: This is the shortest line between the definition points on the surface area.

• Section: A plane is set through the surface. It can be defined by a third point or a direction
vector.

Cut via section

Figure 5.5: Dialog box New Line, tab Cut via Section

In the second tab, specify the points that define the cutting plane. The nodes can be selected
graphically with the button. You can also create a new node with the button.

In the Cut Type section, you define how the cutting line will be created:

• Geodesic: This is the shortest line between the cutting points on the surface area.

• Section: The cutting plane is defined by means of a third point or a direction vector.

Finally, select the Definition Type and specify the parameters of the node or vector, respectively.
The latter represents a unit vector relative to the line between the First Point and Second Point.

The cutting lines are displayed after the mesh has been generated.

Figure 5.6: Cutting lines (orange)
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5.3 Cutting Patterns

To create cutting layouts, the membrane surfaces must be divided into so-called cutting patterns.
These objects can be created by using the membranes' boundary lines as well as user-defined
cutting lines (see Chapter 5.2).

A new cutting pattern can be created on the menu

Insert → Model Data → Cutting Patterns → Dialog Box or Table

or on the Cutting Patterns shortcut menu in the Data navigator.

Figure 5.7: Creating new cutting pattern on shortcut menu

Alternatively, you can use a generator which is accessible on the menu

Tools → Generate Cutting Patterns from Cells.

If you choose the latter, the Create Surfaces from Cells dialog box opens where you can select the
relevant surfaces and disable specific lines, if necessary.

Figure 5.8: Dialog box Create Surfaces from Cells

When the generator is not used, the New Cutting Pattern dialog box opens (see Figure 5.9).
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Figure 5.9: Dialog box New Cutting Pattern

The Boundary Lines of the cutting pattern are represented by “real” lines or cutting lines. They can
be defined graphically with the button. RFEM recognizes intersection points automatically.

When the boundary lines are defined, click the [Create] button to generate the cutting pattern.

The Edit Cutting Pattern dialog box appears.

Figure 5.10: Dialog box Edit Cutting Pattern, tab General
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This dialog box allows for specifications concerning compensation and edge tolerances. The other
dialog tabs are controlled by the parameters activated in the Options section.

General notes
The following principles must be observed when creating a cutting pattern:

• The cutting pattern must not be defined exclusively by cutting lines. There must be at least
one system-relevant boundary line.

• RF-CUTTING-PATTERN checks if adjacent cutting patterns are available. The calculationmakes
sure that common lines have the same lengths.

• RF-CUTTING-PATTERN classifies the lines as boundary or welding lines. In the Line Type tab,
you can change any welding line to a boundary line (see page 52).

Every cutting pattern is symbolized by a big dot in the work window. If a cutting pattern is marked
in red in the Data navigator, it is not correctly defined.

Figure 5.11: Data navigator and symbols of cutting patterns

The [Apply] button in the Cutting Pattern dialog box creates a preliminary shape of the cutting
layout (see Chapter 5.4.2, page 54).

With the [Show Figure or Rendering] button, you can display the view of the cutting pattern in the
graphic area (see Figure 5.14, page 51) instead of the symbols. Then the other buttons become
accessible as well. They have the following functions:

Button Description Function

Overlap
Shows or hides dashed lines of overlap
→ Figure 5.15

Mesh Shows or hides FE mesh

Axes Shows or hides axes of surface

Mirror Mirrors shape of cutting pattern about XZ-plane

Table 5.1: Buttons for rendering option
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Compensation
This tab is available when the Compensation option has been activated in the General tab.

Figure 5.12: Dialog box Edit Cutting Pattern, tab Compensation

Generally, the dimensions of a cutting pattern are reduced by a small percentage so that the
membrane will reach the intended final shape when the prestress is applied. This way, creep
effects of the membrane can be compensated.

Warp andWeft Orientation Setting

The compensation can be specified separately for the warp and weft directions. As Standard,
warps in the direction of the surface axis x andwefts in the direction of its axis y are assumed. If the
structure of the textile is aligned differently for the cutting, the orientation can be rotated about
the angle 𝛼.

The surface axes are shown in the dialog graphic when you switch to the model view by clicking
the [Figure or Rendering] button (see Figure 5.14).

Compensation

A positive value of the compensation reduces the cutting layouts, a negative one extends them
accordingly in the warp or weft directions.

The compensation relates to the non-stressed length of the membrane panel (“original state”).
Then, after prestressing, the final shape e.g. determined by RF-FORM-FINDING is reached with
consideration of the compensation. The compensation cannot be directly determined by the
defined prestress.

You can define a Uniform or Linear compensation. The latter allows for specifying linearly variable
strain components for the warp and weft directions. This may be necessary for conical models.
The strains 𝛥0 and 𝛥1 refer to the edges of the cutting pattern according to the symbols.

When data for compensation is entered, it is necessary to the cutting pattern again
(see Chapter 5.4.2, page 54, paragraph “Final calculation”).
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Different Compensation by Line
This tab is available when the Compensation for boundary line option has been activated in the
General tab.

Figure 5.13: Dialog box Edit Cutting Pattern, tab Different Compensation by Line

Different values of compensation are required when an equality of lines is to be reached, e.g. at
rigid supports. Imagine a boundary fixation of a panel to a steel tube: as the length of the steel
tube is not compensated, the length of the membrane will remain constant there.

In the 𝛥line box, you can enter any global value of the compensation. When the Different check
box has been selected, however, you can set specific lines Active or deactivate them in the table
below and assign each Compensation individually.

The Line Behavior can be described by a compensation or a free relaxation (possibility of displace-
ment). Select the appropriate entry from the list. The two options have the following effects for the
‘ironing process' when the element nodes of the boundary lines are moved to the final locations
to comply with the equilibrium of minimum of energy:

• For a Compensation of 0%, the length of the boundary line is kept equal to the original length.
If a value of e.g. 5 % is defined, however, the “ironing” forces the length of the line to be
shorter than the original one: the final length for fabrication multiplied by 1.05 will give its
length in the FE model after tightening. Therefore, the reference value of 100 % represents
the original model length in RFEM, not the stressed length.

• If a Free relaxation is set, the above-mentioned procedure ignores the boundary conditions
at the edges. The “ironing” will be effectuated without any resistance from the boundary line.
Its final length will not feature any specific relation to the original one.

In the renderingmode, the line of the current row is marked in the selection color (see Figure 5.14).
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Figure 5.14: Rendering mode with selection of active table row

Allowances
This tab is available when the Allowances option has been activated in the General tab.

Figure 5.15: Dialog box Edit Cutting Pattern, tab Allowances

Allowances are needed to attach the membrane to boundary lines, or for overlaps to weld the
panels.

It is possible to define allowances globally For welding lines and For border lines. The line types are
managed in the Line Type tab where they can be adjusted, if required (see description below).
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When theDifferent checkboxhasbeen selected, it is possible to set specific linesActiveordeactivate
them in the table below and assign the Value of each allowance individually.

The parameters can be checked in the dialog graphic when you switch to the model view by
clicking the [Figure or Rendering] button (see Figure 5.15). The line of the current table row is
marked in the selection color.

With the [Pattern Overlap] button, you can display and hide the allowances. This way, you can
check the cutting pattern with and without tolerances.

You can control the graphic by using the mouse functions familiar from RFEM in order to zoom,
shift or rotate the view.

The rendered view is only available when the cutting pattern has been calculated. If you adapt
the values of allowances, however, the cutting pattern does not require any recalculation.

In the RFEM work window, the allowances are shown as dashed lines (see Figure 5.6, page 45).

Line Type
This tab is available when the Line type option has been activated in the General tab.

Figure 5.16: Dialog box Edit Cutting Pattern, tab Line Type

RF-CUTTING-PATTERN defines a line type for every definition line of the cutting pattern. The line is
classified either as Boundary line orWelding line. In general, welding lines are created for adjacent
cutting layouts.

Welding lines affect the overall cutting: RF-CUTTING-PATTERN tries to reach a line equality for both
adjacent cutting edges, as the common line deforms synchronously. For this, the program uses
the average value of the lines from both cutting patterns.

This dialog tab offers you the possibility to change a welding line to the line type Boundary line.

On the contrary, a boundary line cannot be transformed into aWelding line type. Welding lines
are automatically recognized for adjacent cutting patterns that have one common line.
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5.4 Calculation

5.4.1 Calculation Parameters

In the Calculation Parameters dialog box, the Cutting Patterns tab is available when the add-on
module has been enabled. It controls the calculation settings specific for RF- CUTTING-PATTERN.
To open the dialog box, select on the RFEMmenu

Calculate → Calculation Parameters

or click the corresponding button in the toolbar.

Figure 5.17: Dialog box Calculation Parameters, tab Cutting Patterns

Settings
As the cutting patterns are calculated independently of any load case or combination, the specifi-
cations of the global calculation parameters cannot be applied. In this section, you can define the
Maximumnumber of iterations for RF-CUTTING-PATTERN to perform for the flattening procedure.

Precision and Tolerance
It is only rarely necessary to adjust the preset tolerance and smoothing parameters. You can
nevertheless access the text boxes when the Change standard settings option has been selected.

The convergence behavior of the flattening can be affected by the Tolerance for convergence criteria.
The factor 1.0 is set by default. Theminimum factor is 0.01, themaximumvalue is 100.0. The greater
the value is, the more insensitive the break-off limit will be.

The Smoothness of Boundary lines affects the iterative determination of the boundary line shape.
Again, the factor 1.0 is preset. The greater the factor is, the more accurately the boundary lines
will be smoothed. The calculation time increases accordingly.

The Ratio of distance of cutting line node to the FEmesh controls the alignment of cutting lines to
adjacent FE mesh points. The smaller the ratio is, the smoother the line will be created – to the
disadvantage of a distorted meshing. The ratio of 0.01 is preset.



5 RF-CUTTING-PATTERN

©DLUBAL SOFTWARE 2019

54

5
5.4.2 Preliminary and Final Calculation

General information
During the calculation, RF-CUTTING-PATTERN tries to transform the curved surface components
into planar cutting layouts by using an iterative nonlinear method. You may imagine this process
as an “ironing procedure” with the aim to smooth out the curved surfaces.

The calculation uses themeshgeometry of the planar, folded, uni- or bidirectionallly curved surface
components of the cutting patterns and flattens them bymeans of the theory of minimum energy.
Metaphorically speaking, the program tries to press the meshed geometry of the curved surfaces
into a plane, using a press with frictionless press areas. If a state is found where the stresses from
flattening are in equilibrium, a minimum of energy and an optimum of accuracy for the cutting
layout has been reached. To describe it in one more picture: when an orange half is flattened, the
final result will be tension in the external and compression in the internal zones. Those forces will
be in equilibrium.

Preliminary calculation
The calculation is organized in two parts. For the preview of the cutting pattern, a preliminary
flattening calculation will be carried out as soon as you click [Create] (when creating a new cutting
pattern) or [Apply] (when modifying any parameter).

Figure 5.18: [Calculate] and [Apply] buttons in Edit Cutting Pattern dialog box

The “preliminary calculation” (flattening process) determines the cutting pattern in a high-speed
process so that a preview of the flattened pattern can be shown in the dialog graphic.

With the [Apply] function, only the current cutting pattern is analyzed.
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Final calculation

The “final calculation” determines the cutting layouts by applying an isotropic material behavior
(orthotropicmaterial behavior is in preparation). By clicking the [Calculate] button (see Figure 5.18),
a comprehesive flattening calculation is applied to the curved surface components.

The flattening process is carried out by means of the theory of minimum energy. Prestresses
and stresses due to flattening are applied in each main direction by means of a compensation.
Allowances and reductions for welds and boundary connections are considered separately for
every cutting pattern.

The “ironing process” takes an average coordinate system orientation from the curved geometry
and applies those systems with the same rotation to the flattened component.

If adjacent cutting patterns have been defined, their parameters are accordingly considered to
maintain identical lengths.

With the [Calculate] function, all cutting patterns are globally analyzed.

You can observe the iterative calculation process in the FE-Calculationwindow.

Figure 5.19: Calculation process for RF-CUTTING-PATTERN

As a result of the final calculation, you see the coordinates of the cutting patterns shown in the Point
Coordinates dialog tab and in Table 4.45.1 Cutting Patterns - Point Coordinates (see Chapter 5.5).

Cutting patterns which are displayed after the final or preliminary calculation are marked by
different colors. In the Display Properties dialog box, you can see and adjust the corresponding
color settings. To access the dialog box, select on the RFEMmenu

Options → Display Properties → Edit

or right-click a cuttern pattern and select the Display properties option in the shortcut menu.

In the Display Properties dialog box, you can then modify the colors via

Colors → Model Data → Cutting Patterns.
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5.5 Results and Export

When the cutting pattern has been calculated, the new Point Coordinates tab is available in the
Edit Cutting Pattern dialog box.

Dialog box Edit Cutting Pattern

Figure 5.20: Dialog box Edit Cutting Pattern, tab Point Coordinates

In this tab, the shape of the cutting pattern is documented in a table of coordinates. It contains
the new flattened coordinates of the cutting layout for each FE mesh node. The Point Coordinates
are related to the centroid of the selected cutting pattern.

In the graphic area, the cutting pattern with its coordinate system in the centroid is displayed. The
point which has been selected in the table is marked by an arrow. To hide or show the overlapping
areas, use the button. To hide or show the FE mesh of the pattern, use the button.

The areas of the cuttings are displayed in the last Statistics dialog tab.

Figure 5.21: Dialog box Edit Cutting Pattern, tab Statistics (detail)

The 2D area represents the surface area of the “ironed” cutting pattern. The 3D area (the surface
area of the curved surface) is displayed as well for checking purposes. If the values are only slightly
different, a good quality of the flattening process has been obtained.

The dimensions of the cutting pattern are shown as Additional properties. You can see at a glance
whether the production of the panels is possible from the roll material.
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RFEM Tables 4.45 Cutting Patterns
The RF-CUTTON-PATTERN results are also listed in Table 4.45.1 Cutting Patterns - Point Coordinates
and Table 4.45.2 Cutting Patterns - Statistics of RFEM.

Figure 5.22: RFEM table 4.45.1 Cutting Patterns - Point Coordinates

The output is sorted by cutting patterns. For each FE mesh point you see the Point coordinates
without overlaps and the Point coordinates with overlaps.

Figure 5.23: RFEM table 4.45.2 Cutting Patterns - Statistics

The second results table includes the 2D areas of the “ironed” cutting pattern, the 3D areas of the
curved surfaces as well as the Length andWidth of each pattern.
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Printout report
The cutting patterns can be documented in the general printout report of RFEM. In the Printout
Report Selection dialog box, the cutting patterns are managed in the LC/CO Results tab.

Figure 5.24: Selection of cutting patterns in Printout Report Selection dialog box

If you do not want All cutting patterns to appear in the printout report, clear the corresponding
check box. Then, enter the numbers of the relevant objects, or select them graphically by clicking
the button.

Thepoint coordinates andgraphics of the selected cuttingpatterns are incorporated in theprintout
report, as seen in Figure 5.25.
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Figure 5.25: Point coordinates and graphics of cutting patterns in printout report
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DXF export

Exporting cutting patterns

The flattened geometry of the cutting pattern can be exported in a DXF file by selecting

File → Export

on the RFEMmenu or by clicking the corresponding button in the toolbar.

The Export dialog box familiar from RFEM appears.

Figure 5.26: Dialog box Export

To export cutting patterns, select the ASCII Format in the Formats for Cutting Patterns dialog section.

In the Cutting Pattern tab, you can check and adjust the Number of patterns per row and the
Distance between the patterns, if necessary.

Figure 5.27: Dialog box Export, tab Cutting Pattern (.dxf)

Click [OK] to start the export. Then, in the Windows Save As dialog box, enter a file name and the
location where store the DXF file.

A corresponding message appears when the export has been successful.
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Now you can open the DXF file in a CAD program where it can be further edited.

Figure 5.28: Cutting patterns in AutoCAD

Cutting lines as well as allowance lines are organized in different layers.

Exporting shape of model

If you want to export the geometry of the deformed mesh, use the ASCII Formal - Model option
which is available in the General Formats for CAD Programs section of the Export dialog box (see
Figure 5.28). You will then be able to use the shape of the model in a CAD program.

Figure 5.29: FE mesh of deformed model in AutoCAD
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